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SUMMARY:  20 

Here, we present a method to record embryonic muscle contractions in Drosophila embryos in a 21 

non-invasive and detail-oriented manner. 22 

 23 

ABSTRACT:  24 

Coordinated muscle contractions are a form of rhythmic behavior seen early during development 25 

in Drosophila embryos. Neuronal sensory feedback circuits are required to control this behavior. 26 

Failure to produce the rhythmic pattern of contractions can be indicative of neurological 27 

abnormalities. We previously found that defects in protein O-mannosylation, a posttranslational 28 

protein modification, affect the axon morphology of sensory neurons and result in abnormal 29 

coordinated muscle contractions in embryos. Here, we present a relatively simple method for 30 

recording and analyzing the pattern of peristaltic muscle contractions by live imaging of late stage 31 

embryos up to the point of hatching, which we used to characterize the muscle contraction 32 

phenotype of protein O-mannosyltransferase mutants. Data obtained from these recordings can 33 

be used to analyze muscle contraction waves, including frequency, direction of propagation and 34 

relative amplitude of muscle contractions at different body segments. We have also examined 35 

body posture and taken advantage of a fluorescent marker expressed specifically in muscles to 36 

accurately determine the position of the embryo midline. A similar approach can also be utilized 37 

to study various other behaviors during development, such as embryo rolling and hatching.  38 

 39 

INTRODUCTION:  40 

Peristaltic muscle contraction is a rhythmic motor behavior similar to walking and swimming in 41 

humans1–3. Embryonic muscle contractions seen in Drosophila late stage embryos represent an 42 

example of such a behavior. Drosophila is an excellent model organism to study various 43 

developmental processes because embryonic development in Drosophila is well characterized, 44 
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relatively short, and easy to monitor. The overall goal of our method is to carefully record and 45 

analyze the wavelike pattern of contraction and relaxation of embryonic muscles. We used a 46 

simple, non-invasive approach that offers a detailed visualization, recording and analysis of 47 

muscle contractions. This method can also be potentially used to study other in vivo processes, 48 

such as embryonic rolling seen in late stage embryos just prior to hatching. In previous studies, 49 

embryonic muscle contractions were mostly analyzed in terms of frequency and direction1,2. In 50 

order to estimate the relative extent of contractions as they progress along the body axis in the 51 

anterior or posterior direction, we have used embryos expressing GFP specifically in muscles. This 52 

analysis provides a more quantitative way to analyze muscle contractions and to reveal how body 53 

posture in embryos is maintained during series of peristaltic waves of muscle contractions.  54 

 55 

Peristaltic muscle contractions are controlled by central pattern generator (CPG) circuits and 56 

communications between neurons of the peripheral nervous system (PNS), the central nervous 57 

system (CNS), and muscles4,5. Failure to produce normal peristaltic muscle contractions can lead 58 

to defects such as failure to hatch2 and abnormal larval locomotion6 and can be indicative of 59 

neurological abnormalities. Live imaging of peristaltic waves of muscle contraction and detailed 60 

analysis of contraction phenotypes can help uncover pathogenic mechanisms associated with 61 

genetic defects affecting muscles and neural circuits involved in locomotion. We recently used 62 

that approach to investigate mechanisms that result in a body posture torsion phenotype of 63 

protein O-mannosyltransferase (POMT) mutants7. 64 

 65 

Protein O-mannosylation (POM) is a special type of posttranslational modification, where a 66 

mannose sugar is added to serine or threonine residues of secretory pathway proteins8, 9. Genetic 67 

defects in POM cause congenital muscular dystrophies (CMD) in humans10–12. We investigated 68 

the causative mechanisms of these diseases using Drosophila as a model system. We found that 69 

embryos with mutations in Drosophila protein O-mannosyltransferase genes POMT1 and POMT2 70 

(a.k.a. rotated abdomen (rt) and twisted (tw)) show a displacement (“rotation”) of body 71 

segments, which results in an abnormal body posture7. Interestingly, this defect coincided with 72 

the developmental stage when peristaltic muscle contractions become prominent7.  73 

 74 

Since abnormal body posture in POM mutant embryos arises when musculature and epidermis 75 

are already formed and peristaltic waves of coordinated muscle contractions have started, we 76 

hypothesized that abnormal body posture could be a result of abnormal muscle contractions 77 

rather than a defect in muscle or/and epidermis morphology7. CMDs can be associated with 78 

abnormal muscle contractions and posture defects13, and thus the analysis of the posture 79 

phenotype in Drosophila POMT mutants may elucidate pathological mechanisms associated with 80 

muscular dystrophies. In order to investigate the relationship between the body posture 81 

phenotype of Drosophila POMT mutants and possible abnormalities in peristaltic waves of 82 

muscle contractions, we decided to analyze muscle contractions in detail using a live imaging 83 

approach.  84 

 85 

Our analysis of peristaltic contraction waves in Drosophila embryos revealed two distinct 86 

contraction modes, designated as type 1 and type 2 waves. Type 1 waves are simple waves 87 

propagating from anterior to posterior or vice versa. Type 2 waves are biphasic waves that initiate 88 



   

at the anterior end, propagate halfway in the posterior direction, momentarily halt, forming a 89 

temporal static contraction, and then, during the second phase, are swept by a peristaltic 90 

contraction that propagates forward from the posterior end. Wild-type embryos normally 91 

generate a series of contractions that consists of approximately 75% type 1 and 25% type 2 92 

waves. In contrast, POMT mutant embryos generate type 1 and type 2 waves at approximately 93 

equal relative frequencies.  94 

 95 

Our approach can provide detailed information for quantitative analysis of muscle contractions 96 

and embryo rolling7. This approach could also be adapted for analyses of other behaviors 97 

involving muscle contractions, such as hatching and crawling.  98 

 99 

PROTOCOL:  100 

1. Preparation 101 

 102 

1.1. Prepare a fly cage by making approximately 50 holes in a 100 mL capacity tri-corner plastic 103 

beaker using a hot 25 G needle (see Table of Materials).  104 

 105 

1.2. Prepare 60 mm x 15 mm Petri dishes with apple juice-agar (3% agar and 30% apple juice). 106 

 107 

1.3. Prepare fresh yeast paste by mixing dry yeast granules and water. Spread the yeast paste 108 

onto the apple agar plates to increase egg laying. 109 

 110 

1.4. Anaesthetize about 50–60 flies (use approximately equal numbers of males and females) on 111 

CO2 and put them in the fly cage.  112 

 113 

NOTE: Using an increased proportion of females (up to ~2:1 ratio of females:males) may help 114 

increase the amount of laid eggs for some genotypes. 115 

 116 

1.5. Attach an apple juice-agar Petri dish with yeast paste to the fly cage tightly and seal it with 117 

modeling clay. Make sure it is sealed at all corners. 118 

 119 

1.6. Wait until flies wake up from anesthesia and then invert the cage such that the Petri dish is 120 

now at the bottom. Put the cage into an incubator with controlled temperature (25 °C) and 121 

humidity (60%).  122 

 123 

1.7. Allow flies to lay eggs for 2–3 hours, replace the apple plate with a fresh one, and let the 124 

plate with eggs age for 19–20 hours in an incubator.  125 

 126 

NOTE: Prior to the above step, flies must be synchronized to facilitate collection of stage 17e-f 127 

(19-21 h AEL) embryos. This can be achieved by transferring flies to a cage with a fresh yeast-128 

apple juice-agar plate 3–4 times for 12 hours (once every 3–4 hours). Keeping flies at controlled 129 

circadian light environment (LD cycle) can also help with collecting a synchronized population of 130 

embryos, but this was not essential in our experiments.  131 

 132 



   

2. Collection of embryos 133 

 134 

2.1. Carefully pick embryos with a wet paintbrush and place them in a collecting glass dish filled 135 

with 1x PBS. 136 

 137 

2.2. Select the embryos that have their tracheae filled with air. Air-filled tracheae indicate that 138 

embryos have reached Stage 17, and their peristaltic muscle contractions should have begun. 139 

Tracheae become clearly visible when they are filled with air, which can serve as a marker for 140 

Stage 17. 141 

 142 

2.3. Place an apple juice agar slab on a glass slide and carefully transfer embryos from PBS to the 143 

slab. Line up the embryos with their ventral side up. 144 

 145 

NOTE: Dorsal and ventral sides of embryos can be distinguished by the position of dorsal 146 

appendages on the eggshell.  147 

 148 

2.4. Make a rectangular wax boundary on another glass slide using a wax pen (see Table of 149 

Materials).  150 

 151 

2.5. Place a double-sided sticky tape within that boundary and gently pick up the embryos by 152 

lowering this slide onto the agar slab. Apply gentle pressure to ensure that embryos stick to the 153 

tape well, with their dorsal side up. If necessary, embryos can be rolled on the tape to correct 154 

their orientation. Do all manipulations while monitoring embryos under a dissection microscope. 155 

 156 

2.6. Cover embryos with 1x PBS for live imaging of muscle contractions. 157 

 158 

NOTE: Some procedures described above are related to basic Drosophila techniques used in 159 

many studies. More detailed descriptions of common Drosophila techniques can be found 160 

elsewhere14. 161 

 162 

3. Recording of embryos 163 

 164 

3.1. Perform live imaging of mounted embryos on an epiflourescence microscope with a time-165 

lapse function and a digital camera with suitable emission filters (see Table of Materials) using a 166 

10x water immersion objective lens. 167 

 168 

NOTE: Here we used embryos expressing GFP in muscles. Other fluorescent markers with suitable 169 

excitation light and emission filter sets can also be used (e.g., for tdTomato detection, one can 170 

use a Chroma ET-561 filter set for excitation and emission around optimal 554 nm and 581 nm, 171 

respectively).  172 

 173 

3.2. Perform live video recording of embryos using suitable software (see Table of Materials) for 174 

about 1–2 hours with an acquisition rate of 4 frames/s. 175 

 176 



   

NOTE: To analyze rolling of the developing embryo within its shell, embryos without expression 177 

of fluorescent markers can be used. To this end, regular transmitted light illumination without 178 

spectral filters is applied to visualize embryo motion within the shell (See Movie 2). 179 

 180 

4. Analysis of the recordings  181 

 182 

4.1. Export the recorded video directly into Image J for further analyses (e.g., as AVI files). 183 

 184 

4.2. In ImageJ, crop the video recordings to the size of individual embryos by drawing a box 185 

around each embryo and then clicking on Image > Crop. This greatly reduces the size of video 186 

files without affecting its resolution and facilitates their analysis.  187 

 188 

4.3. Rotate cropped images to achieve vertical position of the embryo midline relative to the 189 

screen, by clicking on Image > Transform > Rotate.  190 

 191 

NOTE: Selecting Preview during this process will provide guidance for rotation, showing gridlines 192 

to ensure vertical position of the midline. 193 

 194 

4.4. Analyze embryo rolling: 195 

 196 

4.4.1. Mark the position of one or both tracheae in the first frame of the video at a point midway 197 

between posterior and anterior ends. Click on Analyze > Tools > ROI manager and record this 198 

position as slice number-y coordinate-x coordinate by drawing a box of approximate width of 30 199 

pixels and height of 10 pixels around it and typing t on the keyboard. Ensure that when typing t, 200 

a region of interest is selected on the video. Alternatively, select the Add (t) tab on the ROI 201 

manager to record the position of trachea instead of typing the command.  202 

 203 

NOTE: The region of interest can vary in shape or size depending on the embryonic region or 204 

developmental event being studied.  205 

 206 

4.4.2. Mark the position of the same area of the trachea after each peristaltic contraction. 207 

Measure the distance from the pre-contraction position to the post-contraction position by 208 

drawing a line connecting the centers of each box and typing m on the keyboard. Convert the 209 

distance to micrometers using a known scale of images. Alternatively, measure the distance in 210 

micrometers in a single step by clicking on Analyze > Set Scale and enter the known pixel-to-211 

micron conversion factor to yield a report in microns. 212 

 213 

NOTE: A distance in pixels can be entered together with its corresponding distance in 214 

micrometers.  215 

 216 

4.4.3. Correlate the distance and direction of each rolling event with the direction of muscle 217 

contraction propagation in at least 8 embryos for statistically significant differences. 218 

 219 

4.5. Analyze embryonic muscle contractions: 220 



   

 221 

4.6. Use embryos expressing fluorescent markers in muscles (e.g., we used transgenic flies 222 

expressing a fusion construct of Myosin Heavy Chain promoter and GFP called MHC-GFP5) to 223 

analyze muscle contraction parameters such as contraction amplitude.  224 

 225 

4.7. Use the recording of fluorescent readout and draw a region of interest (e.g., a box of ~40 226 

pixels x 120 pixels) centered on the muscles (which are clearly visible due to the presence of 227 

fluorescent marker) of a particular body segment, and select the Add (t) tab on the ROI manager 228 

to record the position of the ROI. Click on ROI manager > Measure to record the average 229 

fluorescent intensity of each region of interest selected for each frame of the video. 230 

 231 

4.8. Move the box to the centers of other body segments of interest and click on Add (t) in the 232 

ROI manager to record their positions. This will give regions of interest of identical size in all body 233 

segments to be analyzed. Select at least one posterior, one medial, and one anterior segment, 234 

e.g., A7, A4, and T2, respectively. 235 

 236 

4.9. In the ROI manager, select all regions of interest recorded as slice number-y coordinate-x 237 

coordinate (e.g., by selecting while holding Ctrl) and click on More > Multi measure to measure 238 

the mean fluorescent intensity of each region of interest for all frames of the video, and report 239 

each measurement in a table. Each region of interest is a column of the table, and each frame is 240 

a row. Transfer the table to a spreadsheet program for further analyses.  241 

 242 

4.10. Plot a graph with frame number on the x-axis and mean fluorescent intensity on the y-axis. 243 

Frame number can be converted to time using the frame rate (4 frames/s) of the video (Figure 244 

1A). 245 

 246 

4.11. Determine muscle contraction amplitude by estimating the increase in GFP fluorescence 247 

intensity relative to the baseline. Muscle contractions increase the GFP intensity as they bring 248 

more GFP into the vicinity of the focal area as more muscles get pulled in during these 249 

contractions (Movie 1)7. Establish a baseline fluorescence as the average intensity between 250 

contraction waves. Normalize GFP intensity to the baseline by dividing every ROI intensity value 251 

by the baseline intensity. 252 

 253 

NOTE: Each profile has a different baseline fluorescence, as there may be different expression 254 

levels in different muscle segments. One potential complication is that the GFP fluorescence may 255 

change over time due to photo bleaching. This can be resolved by monitoring changes in 256 

fluorescence baseline and using a sufficient sample size for wave analyses (we normally use sets 257 

of 10 fluorescent waves and confirm that the baseline is approximately constant by taking an 258 

average of only those peak minima as baseline that have decreased in fluorescence by 10% or 259 

less relative to the initial minima peak). A pulse-LED illumination may be also applied to mitigate 260 

that problem. 261 

 262 

4.12. Compare muscle contractions on left and right sides of the embryo by analyzing peak 263 

intensities on both sides of the embryo for same segments. Use contraction amplitude and time 264 



   

of peak intensities to examine differences in extent and timing of peristaltic muscle contraction 265 

waves propagating along both sides of the embryo.  266 

 267 

4.13. Compare normalized intensity of GFP at different segments (e.g., at anterior, medial and 268 

posterior regions) during muscle contraction wave propagation to examine changes in the 269 

contraction as the wave propagates. This analysis also determines the direction of the wave (i.e., 270 

whether it propagates toward anterior or posterior regions of the embryo). 271 

 272 

 REPRESENTATIVE RESULTS:  273 

 274 

Normal peristaltic muscle contractions are shown in a WT (wild-type, Canton-S) embryo in Movie 275 

1. The average frequency of peristaltic waves of muscle contractions in our analysis was 47 276 

contractions per hour and the average amplitude was 60% above baseline for WT embryos. 277 

Embryo rolling is shown for a WT embryo in Movie 2, with the white arrow marking the initial 278 

position of a trachea and a black arrow depicting the position of a dorsal appendage. The dorsal 279 

appendage (exterior) does not move whereas the tracheae (interior) does, indicating that the 280 

embryo has rolled within its shell 281 

 282 

In our analysis of pattern of muscle contractions, we designated a peristaltic contraction as a type 283 

1 wave if its profile has a peak that arises at the anterior region first, followed by peaks at middle 284 

and posterior regions (backward wave) or a profile in which the peak first arises at posterior 285 

segments and then propagates toward anterior regions (forward wave) (Figure 2A and Movie 1). 286 

We also observed another type of waves that we designated as Type 2. Type 2 waves start at one 287 

end of the embryo (usually anterior), proceed toward the middle regions, and then return to their 288 

origin as a sweeping wave re-initiated at the opposite end (Figure 2A and Movie 1, wave 4). 289 

POMT mutant embryos show abnormal relative frequency of type 1/type 2 wave generation 290 

(Figure 3), which results in body posture abnormality, the body torsion (or “rotation”) phenotype 291 

(Figure 4).  292 

 293 

Movie 1 shows peristaltic muscle contractions in a wild-type embryo.   294 

 295 

Movie 2 shows embryo rolling in a wild-type embryo. 296 

 297 

Figure 1A shows muscle contraction amplitude monitored over time as normalized GFP intensity 298 

at different embryo segments (anterior, middle and posterior). Peaks during 165-178 s time 299 

period represent a simple forward wave (Type 1). Figure 1B shows that there is no difference in 300 

the amplitude (depicted as GFP intensity) and time of muscle contractions on right and left sides 301 

of the embryo.  302 

 303 

Figure 2 shows Type 1 and Type 2 muscle contraction profiles generated using GFP intensity as a 304 

measure of contraction amplitude. A type 1 wave is a single wave generated at the anterior or 305 

posterior end of the embryo that continues propagation towards the opposite end. Type 2 is a 306 

biphasic wave in which the wave propagates to the middle of the embryo during the first phase 307 

and then returns to the origin as a peristaltic contraction reinitiated at the opposite end. Each 308 



   

wave line represents normalized GFP intensity detected in successive body segments of an 309 

embryo, and peaks correspond to muscle contraction. Slant appearance of the peaks illustrates 310 

that muscle contractions propagate along successive segments, from anterior to posterior, or 311 

vice versa, and thus peaks occur in a consecutive manner in successive body segments.  312 

  313 

Figure 3 includes graphs of contraction wave series in WT and POMT mutant embryos. The graphs 314 

illustrate that Type 2 contraction waves are generated at increased relative frequency in POMT 315 

mutants, as compared to WT embryo. The series of waves in WT embryo (top graph) depicts the 316 

contractions shown in Movie 1.   317 

 318 

Figure 4 shows fixed WT and POMT mutant embryos with muscles stained with fluorescein-319 

conjugated phalloidin to highlight embryo body posture. The curved dashed line illustrates the 320 

body posture phenotype of a POMT mutant. 321 

 322 

FIGURE AND MOVIE LEGENDS:  323 

  324 

Figure 1: Muscle contraction amplitude. (A) GFP intensity is plotted against (Y- axis) time (X-axis) 325 

for different body segments of the embryo. (B) GFP intensity (Y- axis) plotted against time for left 326 

and right sides of the same segment of a contracting embryo. Frame rate is 4 frames/sec for both 327 

graphs. 328 

                                         329 

Figure 2: Type 1 and Type 2 peristaltic muscle contraction wave profiles. (A) Type 1 wave profile 330 

in which individual lines represent normalized GFP intensities of particular body segments over 331 

time, while the peaks indicate contraction events. (B) Type 2 wave profile that shows an example 332 

of a biphasic contraction wave, plotted in the same way as in A.  333 

 334 

Figure 3: Series of contraction waves generated by wild-type and POMT mutant embryos. Blue 335 

and red bars depict Type 1 and Type 2 waves, respectively. Note that the POMT mutant generates 336 

an increased proportion of Type 2 waves, as compared to WT. The WT graph represents 337 

contractions shown in Movie 1. 338 

 339 

Figure 4: Fixed and stained POMT mutant (rt–) and WT embryos. Note the rotation in body 340 

segments of the POMT mutant embryo, highlighted by a dashed line tracing the position of 341 

midline. Muscles are visualized using staining with fluorescein-conjugated phalloidin. Anterior is 342 

to the left, dorsal is up. Scale bar is 100 m. 343 

 344 

Movie 1: Example of peristaltic muscle contractions of a WT embryo. Muscle contractions are 345 

shown in a pseudocolor format to illustrate increase in GFP intensity when contraction occurs 346 

(most bright pixels are red). The video was acquired at 4 frames per second (fps) and is shown at 347 

20 fps. 348 

 349 

Movie 2: A wild-type embryo rolling within its shell. White arrow indicates the initial position of 350 

a trachea, and black arrow indicates the position of a dorsal appendage. Note that as the embryo 351 

rolls, tracheal position changes but the dorsal appendage does not move, which illustrates that 352 



   

the embryo rolls inside its eggshell.  353 

 354 

DISCUSSION:  355 

Our method provides a quantitative way to analyze important embryo behaviors during 356 

development, such as peristaltic muscle contraction waves, including wave periodicity, amplitude 357 

and pattern, as well as wave effect on embryo rolling and posture. This can be useful in analyses 358 

of different mutants to study the role of specific genes in regulating these and other behaviors 359 

during embryonic development. We have used changes in muscle-specific GFP marker intensity 360 

to analyze muscle contraction amplitude, frequency and direction of contraction wave 361 

propagation in embryos. These changes in GFP signal reflect the extent of contractions, as 362 

contracting body segments bring more GFP into an ROI and the vicinity of the focal area. This 363 

approach significantly simplifies analyses and gives a better visual representation of the pattern 364 

of peristaltic contraction waves.  365 

 366 

In our experiments, we used genotypes with muscle-specific transgenic expression of GFP to 367 

visualize and study in detail muscle contractions during embryonic development. Other studies 368 

used a similar approach to analyze larval motion such as crawling and bending5, 15. A similar 369 

technique to study coordinated muscle contractions was previously applied for sandwich 370 

preparation of embryos, which is a more invasive approach that may affect embryo behavior and 371 

development3. In contrast, our method is completely non-invasive and the embryos are 372 

unperturbed during assays. Our protocol doesn’t require the embryos to be dechorionated or 373 

devitellinated, and live embryos of interest can be recovered after assays and propagated for 374 

further analyses.  375 

 376 

Our method can potentially be developed further for a high content analysis (HCA)-based 377 

screening to isolate and analyze mutations that affect embryonic muscle contractions and other 378 

behaviors and developmental processes. This strategy, for instance, can be used to 379 

simultaneously record muscle contractions of many embryos and for assessing their response to 380 

various stimuli, drugs, or environmental changes.  381 
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Name of Material/ Equipment Company Catalog Number Comments/Description

Digital camera

Hamamatsu CMOS 

ORCA-Flash 4.0 C13440-20CU With different emission filters

Forceps FST Dumont 11254-20 Tip Dimensions 0.05 mm x 0.01 mm

LED X-cite BDX (Excelitas) XLED1

Microscope Carl Ziess Examiner D1 491405-0005-000 Epiflourescence with time lapse

Needle BD 305767 25 G x 1-1/2 in

Paintbrush Contemporary crafts Any paintbrush will work

Petri dishes VWR 25384-164 60 mm x 15 mm

Software HCImage Live

Thread Zap Wax pen

Thread Zap II (by 

BeadSmith)(Amazon) TZ1300 Burner Tool

Tricorner plastic beaker VWR 25384-152 100 mL
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Title of Article:  
 
Author(s):  
 
 
Item 1: The Author elects to have the Materials be made available (as described at 
http://www.jove.com/publish) via: 

 Standard Access   Open Access
 
Item 2: Please select one of the following items: 

 The Author is NOT a United States government employee. 

 The Author is a United States government employee and the Materials were prepared in the 
course of his or her duties as a United States government employee. 

 The Author is a United States government employee but the Materials were NOT prepared in the 
course of his or her duties as a United States government employee. 

 
ARTICLE AND VIDEO LICENSE AGREEMENT 

 
1. Defined Terms. As used in this Article and Video 
License Agreement, the following terms shall have the 
following meanings: “Agreement” means this Article and 
Video License Agreement; “Article” means the article 
specified on the last page of this Agreement, including any 
associated materials such as texts, figures, tables, artwork, 
abstracts, or summaries contained therein; “Author” 
means the author who is a signatory to this Agreement; 
“Collective Work” means a work, such as a periodical issue, 
anthology or encyclopedia, in which the Materials in their 
entirety in unmodified form, along with a number of other 
contributions, constituting separate and independent 
works in themselves, are assembled into a collective whole; 
“CRC License” means the Creative Commons Attribution-
Non Commercial-No Derivs 3.0 Unported Agreement, the 
terms and conditions of which can be found at: 
http://creativecommons.org/licenses/by-nc-
nd/3.0/legalcode; “Derivative Work” means a work based 
upon the Materials or upon the Materials and other pre-
existing works, such as a translation, musical arrangement, 
dramatization, fictionalization, motion picture version, 
sound recording, art reproduction, abridgment, 
condensation, or any other form in which the Materials may 
be recast, transformed, or adapted; “Institution” means 
the institution, listed on the last page of this Agreement, by 
which the Author was employed at the time of the creation 
of the Materials; “JoVE” means MyJove Corporation, a 
Massachusetts corporation and the publisher of The Journal 
of Visualized Experiments; “Materials” means the Article 
and / or the Video; “Parties” means the Author and JoVE; 
“Video” means any video(s) made by the Author, alone or 
in conjunction with any other parties, or by JoVE or its 
affiliates or agents, individually or in collaboration with the 
Author or any other parties, incorporating all or any portion 

of the Article, and in which the Author may or may not 
appear. 
2. Background. The Author, who is the author of the 
Article, in order to ensure the dissemination and protection 
of the Article, desires to have the JoVE publish the Article 
and create and transmit videos based on the Article. In 
furtherance of such goals, the Parties desire to memorialize 
in this Agreement the respective rights of each Party in and 
to the Article and the Video. 
3. Grant of Rights in Article. In consideration of JoVE 
agreeing to publish the Article, the Author hereby grants to 
JoVE, subject to Sections 4 and 7 below, the exclusive, 
royalty-free, perpetual (for the full term of copyright in the 
Article, including any extensions thereto) license (a) to 
publish, reproduce, distribute, display and store the Article 
in all forms, formats and media whether now known or 
hereafter developed (including without limitation in print, 
digital and electronic form) throughout the world, (b) to 
translate the Article into other languages, create 
adaptations, summaries or extracts of the Article or other 
Derivative Works (including, without limitation, the Video) 
or Collective Works based on all or any portion of the Article 
and exercise all of the rights set forth in (a) above in such 
translations, adaptations, summaries, extracts, Derivative 
Works or Collective Works and(c) to license others to do any 
or all of the above. The foregoing rights may be exercised in 
all media and formats, whether now known or hereafter 
devised, and include the right to make such modifications 
as are technically necessary to exercise the rights in other 
media and formats. If the “Open Access” box has been 
checked in Item 1 above, JoVE and the Author hereby grant 
to the public all such rights in the Article as provided in, but 
subject to all limitations and requirements set forth in, the 
CRC License. 

License

Live imaging and analysis of muscle contractions in Drosophila embryo

Ishita Chandel, Ryan Baker, Naosuke Nakamura, and Vlad Panin

X

X
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4. Retention of Rights in Article. Notwithstanding 
the exclusive license granted to JoVE in Section 3 above, the 
Author shall, with respect to the Article, retain the non-
exclusive right to use all or part of the Article for the non-
commercial purpose of giving lectures, presentations or 
teaching classes, and to post a copy of the Article on the 
Institution’s website or the Author’s personal website, in 
each case provided that a link to the Article on the JoVE 
website is provided and notice of JoVE’s copyright in the 
Article is included. All non-copyright intellectual property 
rights in and to the Article, such as patent rights, shall 
remain with the Author. 
5. Grant of Rights in Video – Standard Access. This 
Section 5 applies if the “Standard Access” box has been 
checked in Item 1 above or if no box has been checked in 
Item 1 above. In consideration of JoVE agreeing to produce, 
display or otherwise assist with the Video, the Author 
hereby acknowledges and agrees that, Subject to Section 7 
below, JoVE is and shall be the sole and exclusive owner of 
all rights of any nature, including, without limitation, all 
copyrights, in and to the Video. To the extent that, by law, 
the Author is deemed, now or at any time in the future, to 
have any rights of any nature in or to the Video, the Author 
hereby disclaims all such rights and transfers all such rights 
to JoVE. 
6. Grant of Rights in Video – Open Access. This 
Section 6 applies only if the “Open Access” box has been 
checked in Item 1 above. In consideration of JoVE agreeing 
to produce, display or otherwise assist with the Video, the 
Author hereby grants to JoVE, subject to Section 7 below, 
the exclusive, royalty-free, perpetual (for the full term of 
copyright in the Article, including any extensions thereto) 
license (a) to publish, reproduce, distribute, display and 
store the Video in all forms, formats and media whether 
now known or hereafter developed (including without 
limitation in print, digital and electronic form) throughout 
the world, (b) to translate the Video into other languages, 
create adaptations, summaries or extracts of the Video or 
other Derivative Works or Collective Works based on all or 
any portion of the Video and exercise all of the rights set 
forth in (a) above in such translations, adaptations, 
summaries, extracts, Derivative Works or Collective Works 
and (c) to license others to do any or all of the above. The 
foregoing rights may be exercised in all media and formats, 
whether now known or hereafter devised, and include the 
right to make such modifications as are technically 
necessary to exercise the rights in other media and formats. 
For any Video to which this Section 6 is applicable, JoVE and 
the Author hereby grant to the public all such rights in the 
Video as provided in, but subject to all limitations and 
requirements set forth in, the CRC License. 
7. Government Employees. If the Author is a United 
States government employee and the Article was prepared 
in the course of his or her duties as a United States 
government employee, as indicated in Item 2 above, and 
any of the licenses or grants granted by the Author 
hereunder exceed the scope of the 17 U.S.C. 403, then the 
rights granted hereunder shall be limited to the maximum 

rights permitted under such statute. In such case, all 
provisions contained herein that are not in conflict with 
such statute shall remain in full force and effect, and all 
provisions contained herein that do so conflict shall be 
deemed to be amended so as to provide to JoVE the 
maximum rights permissible within such statute. 
8. Protection of the Work. The Author(s) authorize 
JoVE to take steps in the Author(s) name and on their behalf 
if JoVE believes some third party could be infringing or 
might infringe the copyright of either the Author’s Article 
and/or Video. 
9. Likeness, Privacy, Personality. The Author hereby 
grants JoVE the right to use the Author’s name, voice, 
likeness, picture, photograph, image, biography and 
performance in any way, commercial or otherwise, in 
connection with the Materials and the sale, promotion and 
distribution thereof. The Author hereby waives any and all 
rights he or she may have, relating to his or her appearance 
in the Video or otherwise relating to the Materials, under 
all applicable privacy, likeness, personality or similar laws. 
10. Author Warranties. The Author represents and 
warrants that the Article is original, that it has not been 
published, that the copyright interest is owned by the 
Author (or, if more than one author is listed at the beginning 
of this Agreement, by such authors collectively) and has not 
been assigned, licensed, or otherwise transferred to any 
other party. The Author represents and warrants that the 
author(s) listed at the top of this Agreement are the only 
authors of the Materials. If more than one author is listed 
at the top of this Agreement and if any such author has not 
entered into a separate Article and Video License 
Agreement with JoVE relating to the Materials, the Author 
represents and warrants that the Author has been 
authorized by each of the other such authors to execute this 
Agreement on his or her behalf and to bind him or her with 
respect to the terms of this Agreement as if each of them 
had been a party hereto as an Author. The Author warrants 
that the use, reproduction, distribution, public or private 
performance or display, and/or modification of all or any 
portion of the Materials does not and will not violate, 
infringe and/or misappropriate the patent, trademark, 
intellectual property or other rights of any third party. The 
Author represents and warrants that it has and will 
continue to comply with all government, institutional and 
other regulations, including, without limitation all 
institutional, laboratory, hospital, ethical, human and 
animal treatment, privacy, and all other rules, regulations, 
laws, procedures or guidelines, applicable to the Materials, 
and that all research involving human and animal subjects 
has been approved by the Author's relevant institutional 
review board. 
11. JoVE Discretion. If the Author requests the 
assistance of JoVE in producing the Video in the Author’s 
facility, the Author shall ensure that the presence of JoVE 
employees, agents or independent contractors is in 
accordance with the relevant regulations of the Author's 
institution. If more than one author is listed at the 
beginning of this Agreement, JoVE may, in its sole 
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discretion, elect not take any action with respect to the 
Article until such time as it has received complete, executed 
Article and Video License Agreements from each such 
author. JoVE reserves the right, in its absolute and sole 
discretion and without giving any reason therefore, to 
accept or decline any work submitted to JoVE. JoVE and its 
employees, agents and independent contractors shall have 
full, unfettered access to the facilities of the Author or of 
the Author’s institution as necessary to make the Video, 
whether actually published or not. JoVE has sole discretion 
as to the method of making and publishing the Materials, 
including, without limitation, to all decisions regarding 
editing, lighting, filming, timing of publication, if any, 
length, quality, content and the like.  
12. Indemnification. The Author agrees to indemnify 
JoVE and/or its successors and assigns from and against any 
and all claims, costs, and expenses, including attorney’s 
fees, arising out of any breach of any warranty or other 
representations contained herein. The Author further 
agrees to indemnify and hold harmless JoVE from and 
against any and all claims, costs, and expenses, including 
attorney’s fees, resulting from the breach by the Author of 
any representation or warranty contained herein or from 
allegations or instances of violation of intellectual property 
rights, damage to the Author’s or the Author’s institution’s 
facilities, fraud, libel, defamation, research, equipment, 
experiments, property damage, personal injury, violations 
of institutional, laboratory, hospital, ethical, human and 
animal treatment, privacy or other rules, regulations, laws, 
procedures or guidelines, liabilities and other losses or 
damages related in any way to the submission of work to 
JoVE, making of videos by JoVE, or publication in JoVE or 
elsewhere by JoVE. The Author shall be responsible for, and 
shall hold JoVE harmless from, damages caused by lack of 
sterilization, lack of cleanliness or by contamination due to 

the making of a video by JoVE its employees, agents or 
independent contractors. All sterilization, cleanliness or 
decontamination procedures shall be solely the 
responsibility of the Author and shall be undertaken at the 
Author’s expense. All indemnifications provided herein 
shall include JoVE’s attorney’s fees and costs related to said 
losses or damages. Such indemnification and holding 
harmless shall include such losses or damages incurred by, 
or in connection with, acts or omissions of JoVE, its 
employees, agents or independent contractors. 
13. Fees. To cover the cost incurred for publication, 
JoVE must receive payment before production and 
publication the Materials. Payment is due in 21 days of 
invoice. Should the Materials not be published due to an 
editorial or production decision, these funds will be 
returned to the Author. Withdrawal by the Author of any 
submitted Materials after final peer review approval will 
result in a US$1,200 fee to cover pre-production expenses 
incurred by JoVE. If payment is not received by the 
completion of filming, production and publication of the 
Materials will be suspended until payment is received. 
14. Transfer, Governing Law. This Agreement may be 
assigned by JoVE and shall inure to the benefits of any of 
JoVE’s successors and assignees. This Agreement shall be 
governed and construed by the internal laws of the 
Commonwealth of Massachusetts without giving effect to 
any conflict of law provision thereunder. This Agreement 
may be executed in counterparts, each of which shall be 
deemed an original, but all of which together shall be 
deemed to me one and the same agreement. A signed copy 
of this Agreement delivered by facsimile, e-mail or other 
means of electronic transmission shall be deemed to have 
the same legal effect as delivery of an original signed copy 
of this Agreement.

 
A signed copy of this document must be sent with all new submissions. Only one Agreement is required per submission. 

 
CORRESPONDING AUTHOR 
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Department:   
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Title:   
 

Signature:  
 

Date:  

Please submit a signed and dated copy of this license by one of the following three methods: 
1. Upload an electronic version on the JoVE submission site 
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3. Mail the document to JoVE / Attn: JoVE Editorial / 1 Alewife Center #200 / Cambridge, MA 02140 
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We thank the editor and the reviewers for overall positive evaluation of our manuscript. 
We appreciate reviewers’ comments and critiques that helped us to revise the 
manuscript. We believe that this improved the quality of our manuscript. We hope that 
our revised manuscript will be found acceptable for publication. 
Below is our response, point by point, to the reviewers’ critiques and editorial comments. 
 
Reviewer #1: 
 
Minor Concerns: 
Lines 48-85: consider combining paragraphs to shorten introduction. For methods paper, 
there is too much focus on previous results. Instead, emphasize the use of the method 
and explain the author's application for the method as well as different possible 
applications. 
Response: The suggested changes have been made. Please see lines 44-70 and lines 
108-111. 
 
Line 107: clarify/elaborate. Should users replace agar plates every 3 hours, and then 
grow for 20 hours? This explanation was unclear. 
Response: This has been clarified. Please see 1.7 and lines 140-142. 
 
Line 116: Explain why take embryos whose trachea are expanded. Describe in detail 
how such embryos can be distinguished from others. 
Response: This detail has been included. Please see 2.2. 
 
Line 151: A few notes on potential problems in mounting or imaging and possible 
solutions may be helpful. 
Response: Our mounting and staging technique is quite standard and notes are 
provided throughout the protocol to avert possible problems that may occur during these 
steps. 
 
Line 171: I suggest dividing the analysis section in subsections e.g. 4a-measuring 
contractions by tracheal position, 4bmeasuring contraction with muscle specific GFP 
expression. 
Response: This suggestion has also been included. Please see 4a (line 216) and 4b 
(line 248). 
 
Line 285: more comments on general use or other applications of methods here (and/or 
in introduction). 
Response: Suggested changes have been made in the introduction and further 
applications of the method are mentioned in the discussion (lines 404-408). 
 
Reviewer # 2: 
 
Major Concerns: 
1. The most serious concern I have is that the method aims at quantifying contraction 
frequencies and amplitudes (see abstract), however it does not do that as presented. 
Not a single number is given. Without a major revision including these numbers I do not 
believe that this protocol will be very useful. Robustness needs to be shown. What 
number of animals is needed for a statistically significant difference? 
 
Response: Number of embryos analyzed for both kinds of analysis in the paper was at 

Rebuttal Letter Click here to access/download;Rebuttal Letter;Rebuttal_fnl.docx
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least 8. This information is now included in the manuscript (line 244). An example how 
relative frequencies of  Type 1 and 2 waves can be analyzed by our method is shown in 
new Figure 4 for wild-type and POMT mutants. More extended analyses of series of 
contraction waves using our protocol can be also found in Baker et al, 2018 (ref. [7]).  
 
Minor Concerns: 
2. The intro could mention the difference of type 1 vs type 2 waves. 
Response: Type 1 vs. type 2 difference is now included in the introduction. (Lines 96-
104). 
 
3. Staging will not be precise if the plate is changed every 12h. This would require a 
change every hour (1.7). 
Response: We do not advise to change the plate every 12 h, rather we suggest to 
change the plate 3-4 times every 12 hrs (see note on 1.7.). In addition, for more precise 
staging, we use the event of trachea been filled with air (stage 17e, Pereanu et al 2007).  
 
4. As the embryos are not dechorionated, they will not dry out. Thus, the statement in 
the protocol is incorrect (2.6). 
Response: This statement has been corrected.  
 
5. Type 2 waves seem to split rather than to invert, thus the text is not accurate. 
Response: We did not indicate that type 2 waves invert. Rather, we describe a type 2 
wave as biphasic, with opposite direction of propagation at the two phases. We think that 
describing the type 2 wave as a split wave would be less clear and potentially confusing.  
 
6. Figure 3 has no labeling. 
Response: Genotypes and dashed lines showing rotation of body segments have been 
added to Fig 3. 
 
7. Senseless mutants are mentioned in the introduction but not elsewhere. Either delete 
or mention them in the results section. 
Response: We have deleted the mention of sens mutants. 
 
Reviewer # 3: 
 
Major Concerns: 
1. The precision of using a box to mark trachea positions (section 4.4) is not clear to me. 
A point may be more precise, but at the very least the authors should list the size of the 
box. 
Response: The idea here is to mark and record the position of the trachea before and 
after muscle contractions because when the embryo rolls inside the eggshell the position 
of the trachea changes. This can be achieved by using a box or a point (as pointed out 
by the reviewer). A relatively small rectangular box, e.g., ~ 30x10 pixels, is sufficient to 
mark and record the position of the trachea. This information is now included in the 
manuscript (See 4a). 
 
2. Regarding the muscle contraction analysis, it is not clear what is in the ROI that the 
authors are measuring. Is there a specific muscle, or set of muscles that is being 
measured? 
Response: The ROI has fluorescent readout from muscles in it and we are measuring 
its intensity because when muscles contract the GFP intensity increases as compared to 



baseline. Ideally, the ROI should include all muscles from one anterior, one medial and 
one posterior body segment should be taken for analysis of wave patterns. To illustrate 
this better we have now included a movie that demonstrates muscle contractions and 
how fluorescence readout increases in response to contractions (See Movie 1). 
 
3. It is unclear to me how the GFP fluorescence increased as a function of muscle 
contraction (section 4.11). Did additional muscles get pulled into the ROI? Are the 
authors now measuring a smaller region with the same amount of GFP because the 
muscle is contracted? 
Response: Muscle contractions increase the GFP intensity as they bring more GFP into 
the vicinity of the focal area1 (Section 4b, lines 282-284). This is demonstrated in the 
movie of muscle contractions that we have now included in our manuscript (Movie 1). 
 
4. I do not think that normalized GFP intensity can necessarily be an indication of 
contraction strength (section 4.12). It might be extent of contraction, but "strength" 
indicates force production. 
Response: We have changed “strength” to “extent” throughout the manuscript. 
 
5. I suppose the eventual video will mitigate some of this, but in many cases it took effort 
to determine exactly how a protocol would be completed. Cartoons showing how boxes 
are drawn and ROIs are determined could be of great help to the eventual readers. 
Response: The reviewer is correct to point out that the eventual video will mitigate the 
confusion, but we have made additional changes and added movies and graphs that will 
help the reader to follow the protocol better. Drawing boxes in Image J is fairly 
straightforward and determining ROIs depends upon what the reader is interested in 
analyzing. E.g., we drew ROIs around trachea and muscles for our analysis. The video 
will also circumvent these concerns. 
 
6. How the data in Figure 2A was generated is not clear to me. Better description of what 
the figure is, or another cartoon, could be of great help. 
Response: Figure 2A shows an example of a peristaltic muscle contraction wave 
obtained by drawing ROIs and measuring normalized GFP intensity for muscle 
segments in an embryo over time. Each wavy line represents normalized GFP intensity 
from different anterior and posterior body segments of an embryo and peaks represent 
muscle contraction. The peaks appear slant because muscle contractions begin in a 
particular anterior/posterior segment and then occur in other segments in a consecutive 
manner (anterior to posterior or posterior to anterior). They do not occur simultaneously 
in all body segments. Therefore, muscle contraction peaks appear one after other 
throughout the body segments over time. 
 
Minor Concerns: 
1. Section 3.4 what is the acquisition rate? 
Response: 4 frames/second, see 3.2. 
 
2. Section 4 might be more accessible to the reader if it were divided into two sections 
(1) embryo rolling and (2) muscle contractions. 
Response: This suggestion has been incorporated as Section 4a and 4b in the 
manuscript. 
 
3. Line 175: You say, "Alternatively, the distance can be measured in pixels". I think that 
you mean microns. 



Response: Yes, this has been corrected. 
 
 
Reviewer # 4: 
 
Minor Concerns: 
*Please add a concluding sentence at the end of Introduction to summarize the 
observations and lead to protocol. 
Response: Added, see lines 108-111. 
 
*Protocol, section 1.7, "allow flies to lay eggs for 19-20 hrs": This seems to be a lengthy 
window for egg laying, because eggs collected after this time window will be 020 hours 
old and therefore they would not be synchronized. Wouldn't it be better to use more adult 
females, decrease the egg laying time window to 24 hours, and then age the eggs laid in 
this time window until they are 19-20 hours old? 
Response: We agreed with the Reviewer and made the suggested changes (see 1.4 
and 1.7). 
 
*Protocol, section 2.3: It will be helpful if the authors show an image or provide some 
description so that the reader knows how to differentiate ventral from dorsal side in 
embryos at that stage. 
Response: This has now been added, see note on 2.3. 
 
*Protocol, section 4.14, and line 221: … if its profile has a peak, “which” arises at the 
anterior … 
Response: Grammar Corrected, See representative results, line 328. 
 
*Figure and Table legends, line 242: Instead of "Fig 1 A." use "Fig 1. A." 
Response: Legends fixed. 
 
Reviewer # 5: 
 
Major Concerns: 
1. It was surprising that the authors do not provide actual examples of visualizing wild-
type or defective muscle contraction. Only single images are provided, which could be 
accomplished with fixed tissue. A movie of this type is critical to someone using this 
method for experimental analysis. We do not see what peristaltic movements, for 
example, mean or how one determines that these are defective. 
Response: To make sure our readers understand what peristaltic muscle contractions 
are, we have included an example of movie (Movie 1), as well as graphs that depict 
series of contraction waves in WT and POMT mutants (Fig.4), illustrating that mutants 
generate a higher proportion of type 2 peristaltic waves, which is a characteristic 
phenotype of these mutants.   
 
2. Related to the above, even a series of still images from a time-lapse analysis of 
muscle contraction with time stamps would be helpful and seems appropriate. 
Response: To illustrate peristaltic muscle contractions, we included movies that show 
fluorescent (Movies 1) and regular light (Movie 2) images of contraction waves.  
 
3. Diagrams of the method of mounting embryos and diagrams/overlays of how 
measurements were taken is also appropriate. These details are unique to this particular 



method, and should be fully explained with visual aids/examples. 
Response: Our mounting and staging techniques are standard and routinely done (as 
pointed out by the reviewer) and are mentioned elsewhere2. Drawing ROIs for taking 
measurements in Image J is fairly straightforward and will be shown in the eventual 
video. 
 
4. In contrast to Parts 1 and 2, much of which is available elsewhere, Part 3 is lacking 
many details that would ensure success. For example 1) how often is an image collected 
over the 3-hour period? 2) How is the embryo kept in place and in focus when it begins 
significant muscle contraction? 3) How is the embryo kept alive and hydrated during this 
time but does not drown from lack of oxygen for this three hour period (simply placing 
PBS on a slide is not sufficient if one is imaging for 3 hours, 4) how did they prevent 
photobleaching of the GFP, 5) what magnification is adequate, and so on. Also, what 
drivers and fluorophores are adequate for robust muscle expression (stock sources, 
genotypes of successful combinations and options are appropriate). The "Protocol" 
simply lists the equipment used. Does this mean that someone who does not have these 
specific resources or someone not familiar with this particular microscope or software 
cannot use this protocol in any manner? The method should be translatable to other 
setups. What type of image is saved, for example (see below). 
Response: 1) The video is a continuous video of approximately 1-2 hrs and can be 
taken continuously up to the point of embryo hatching. 2) The embryo is inside the 
eggshell, which is sticking to a tape and thus does not move significantly when 
contracting. 3) The embryo remains alive and hydrated and PBS can be replenished if 
need be without disturbing the microscope setup or the embryo slide as we use water 
immersion lenses. 4) Photo bleaching of GFP is a potential complication and we have 
explained in detail how to circumvent this potential problem (see Note in section 4b. 6) 
Adequate magnification used is 10X and is mentioned in Section 3.1. We have not used 
any muscle specific Gal4 driver rather we have used a transgenic fusion construct of 
myosin heavy chain promoter and GFP (MHC-GFP) to express GFP in muscles (See 
section 4b). Other fluorophores have also been mentioned in the manuscript (See note 
in 3.1). The equipment details have been moved to table of materials. We are sure other 
microscopes and software setups can be suitable for using with this protocol but for 
analysis we have only used Image J and would recommend using that. 
 
5. Part 4 is good on some details of how data is collected but is lacking in others. For 
example, how does one recognize that an embryo is rolling in the image? 
(What does this look like? A movie or series of time point images of an example again 
seems appropriate). 
Response: The reviewer brings a good point here and to that end we have included a 
movie (Movie 2) showing a WT embryo rolling.  
 
Minor Concerns: 
1. Much of the experimental detail provided to the reader is general and very redundant 
with many other publications. Parts 1 and 2 describe very routine methods for embryo 
collection that have been available for more than 2 decades. These do not merit 
publication but, at the very least, none are cited. 
Response: We agree that Parts 1 and 2 include elements of routine methods that were 
used in many previous studies. We decided to provide the description of these well-
known steps, instead of simply including references, for a more complete and 
convenient protocol that can be easily used by researchers even without significant 
experience of working with Drosophila. However, per reviewer’s suggestion, we  added 



now a reference for a well-known compendium of Drosophila techniques that describes 
in greater detail some basic procedures related to our protocol, such as handling flies 
and collecting embryos (Roberts 1998). 
 
2. It would be useful to include a section on troubleshooting. One example where this 
might be useful in Part 2 is on line 125 where they state that embryos will stick to the 
tape with their dorsal side up. This seems surprising unless one positions the embryos, 
so more information on this aspect would be useful. 
Response: This is a routine procedure and embryos can be easily positioned this way. 
Embryos with the chorion tend to stick well to adhesive tape, but they still can be rolled 
to achieve   necessary orientation. We added this information in section 2.5. 
 
3. Detail in this last section discusses general guidelines for imaging ("crop images to 
make file smaller") but does not mention image resolution or whether this is modified. 
Others such as the file type that can be successfully imported into ImageJ, necessary 
plugins, and so on may be very useful in translating this procedure to other microscopes 
or dedicated software.  
Response: We included details on video resolution and file type in 4.2 and 4.1, 
respectively. 
 
Reviewer # 6: 
 
Major Concerns: 1. It needs major improvement in grammar and detail for a reader to 
follow.  
Response: We edited the manuscript to add more details, and improve its clearness 
and grammar.  
 
2. It is also recommended that the authors alter the figures to include, as important 
examples, wave data from the mutants so that the reader can see "mutant behavior". 
Response: As suggested, we included examples of wave movies (Movies 1, 2) and 
graphs that illustrate mutant behavior in wave generation (Fig. 4)  
 
Minor Concerns:  
2. Summary is misleading. The authors are not recording embryonic developmental 
processes. The authors are recording muscle contraction. 
Response: Changes to the summary have been made as suggested 
 
3. In the abstract, coordinated muscle contractions are not seen "early" during 
development in the Drosophila embryo (early in embryonic development is stage 5 for 
example). Coordinated contraction occurs at the end of embryonic development (stage 
17). To that end, instead of stages, hours after egg laying should be included. 
Response: Hours after egg laying (AEL) are now included, see note in 1.7. 
 
4. At the end of the introduction, the authors mention briefly that Senseless mutants also 
show abnormal contraction patterns. These data should be included so that the readers 
have a sense of the different types of contraction behaviors that can be identified with 
this technique. Also it would be wise to include a conclusion at the end of the 
introduction. As is, the reader is left hanging. 
Response: To avoid confusion and make the introduction more straightforward, we 
removed the mention of senseless mutants. Detailed information on contractions of sens 
mutants can be found in ref. [7], however, it’s beyond the main scope of our manuscript.   



5. The manuscript, but particularly the protocol, is poorly written and filled with 
grammatical mistakes. The authors should rewrite the manuscript using the same tense 
and in a more formal tone. The manuscript should be edited so that it is not vague and 
please remove jargon. More detail should be given. As examples, what are the 
genotypes of the "wildtype" embryos with green muscles? How many different muscle 
GAL4 drivers have been tested? Do the wave patterns change depending on which 
driver (with associated background) is used? One could imagine differences in wave 
patterns with different "wildtype" controls. The authors should also be consistent in terms 
of using abbreviations and while referring to Image J functions and commands. i.e. how 
to find the command in ImageJ. 
Response: Wildtype is Canton-S. The green muscles are a green fluorophore 
conjugated to a stain called phalloidin, which stains actin filaments of muscles (See Fig 3 
legend). Muscle Gal4 driver has not been used instead we used a fusion construct of 
myosin heavy chain promoter and GFP (MHC-GFP) to express GFP in muscles (See 
section 4b). To the best of our knowledge different Gal4 drivers should not significantly 
change wave patterns but then we can’t say for sure.  These details are now added to 
the manuscript.  
 
6. In the protocol and abstract the authors mentioned that this technique could be used 
to examine other embryo behaviors like "rolling" and "hatching". However, the authors 
have not explained how to analyze and interpret embryos "rolling" or "hatching" in 
control or mutant embryos. They have also not provided any graphs or images to 
demonstrate this process. 
Response: We have added a rolling video for a wild type embryo (Movie 2). POMT 
mutants do not show defects in embryo rolling, but our method can be useful to assess 
rolling in other mutants Similarly, our live imaging approach can be used for studying 
hatching or other embryo movements during late embryonic stages. 
 
 
 
 
Responses to editorial comments 
 
1. Please take this opportunity to thoroughly proofread the manuscript to ensure that 
there are no spelling or grammar issues. 
Response: We corrected spelling and grammar issues. 
 
2. Please provide an email address for each author. 
Response: We have provided the email addresses of all authors  (lines 13-15). 
 
3. Please revise the Introduction to include the following: A clear statement of the overall 
goal of this method; The advantages over alternative techniques with applicable 
references to previous studies; Description of the context of the technique in the wider 
body of literature; Information that can help readers to determine if the method is 
appropriate for their application. Please focus on the general types of results acquired. 
Response: We have included the information requested above in the introduction (lines 
50-60). 
 
4. Please use SI abbreviations for all units: L, mL, μL, h, min, s, etc. Please use the 
micro symbol μ instead of u. Please abbreviate liters to L to avoid confusion. 
Response: These changes have been made throughout the manuscript. 



 
5. Please include a space between all numerical values and their corresponding units: 
15 mL, 37 °C, 60 s; etc. 
Response: These changes have been made. 
 
6. JoVE cannot publish manuscripts containing commercial language. This includes 
trademark symbols (™), registered symbols (®), and company names before an 
instrument or reagent. Please remove all commercial language from your manuscript 
and use generic terms instead. All commercial products should be sufficiently referenced 
in the Table of Materials and Reagents. You may use the generic term followed by “(see 
table of materials)” to draw the readers’ attention to specific commercial names. 
Examples of commercial sounding language in your manuscript are: Carl Zeiss, 
Hamamatsu, HCImage, etc.  
Response: We have moved commercial information about the microscope, camera etc., 
to the table of materials. Our analysis part of the protocol however pertains to specific 
software “Image J” and is still included in the protocol itself. 
 
7. Please revise the protocol text to avoid the use of any personal pronouns (e.g., "we", 
"you", "our" etc.). 
Response: We have removed personal pronouns throughout the protocol except for a 
few notes within the protocol. 
 
8. Please revise the protocol to contain only action items that direct the reader to do 
something (e.g., “Do this,” “Ensure that,” etc.). The actions should be described in the 
imperative tense in complete sentences wherever possible. Avoid usage of phrases 
such as “could be,” “should be,” and “would be” throughout the Protocol. Any text that 
cannot be written in the imperative tense may be added as a “Note.” Please include all 
safety procedures and use of hoods, etc. However, notes should be used sparingly and 
actions should be described in the imperative tense wherever possible. Please move the 
discussion about the protocol to the Discussion. 
Response: The tense of the protocol is now imperative wherever possible except for a 
few “notes”. We have discussed the protocol in the discussion. 
 
9. Section 4: Software steps must be more explicitly explained ('click', 'select', etc.). 
Please add more specific details (e.g. button clicks for software actions, numerical 
values for settings, etc.). 
Response: Software steps are now explained in more detail and numerical values for 
certain ROIs have been provided (see edits in Section 4). 
 
10. 1.1: Please specify the capacity of the beaker used. How many holes are made? 
What is the size of the needle? 
Response: Information requested above is now included in 1.1. 
 
11. 1.4: Approximately how many flies are needed? 
Response: Information added in 1.4. 
 
12. 3.1-3.5,4.1-4.14:Please write the text in the imperative tense to direct the reader to 
do something (e.g., “Do this,” “Ensure that,” etc.). 
Response: The tense has been changed to imperative throughout the protocol. 
 
13. Please combine some of the shorter Protocol steps so that individual steps contain 



2-3 actions and maximum of 4 sentences per step. 
Response: These recommended changes have been made throughout the protocol. 
 
14. After you have made all the recommended changes to your protocol (listed above), 
please highlight 2.75 pages or less of the Protocol (including headings and spacing) that 
identifies the essential steps of the protocol for the video, i.e., the steps that should be 
visualized to tell the most cohesive story of the Protocol. 
Response: Done.  
 
15. Please highlight complete sentences (not parts of sentences). Please ensure that the 
highlighted part of the step includes at least one action that is written in imperative tense. 
Notes cannot usually be filmed and should be excluded from the highlighting. Please do 
not highlight any steps describing anesthetization and euthanasia. 
Response: Done. 
 
16. Please include all relevant details that are required to perform the step in the 
highlighting. For example: If step 2.5 is highlighted for filming and the details of 
how to perform the step are given in steps 2.5.1 and 2.5.2, then the substeps 
where the details are provided must be highlighted. 
Response: Done. 
 
17. Discussion: Please discuss critical steps within the protocol. 
Response: Critical step moved to the protocol (see Note on step 6 of 4b). 
 
18.Figures 1 and 2: Please change the time unit “sec” to “s”. Please combine all panels 
of one figure into a single image file. Please include a title for each figure in 
the figure legend. 
Response: The recommended changes have been made.  
 
19. Table of Equipment and Materials: Please sort the items in alphabetical order 
according to the name of material/equipment. 
Response: Items are now sorted in alphabetical order in the revised table of materials. 
 
20. References: Please do not abbreviate journal titles. 
Response: Full journal titles are now provided.  
 
 
 
 


